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Creating Custom Panel Schedules with 
AutoCAD MEP 2009 
In AutoCAD® MEP 2009 software, electrical panel schedules are 
created with AutoCAD® software tables instead of being generated 
by Microsoft® Visual Basic® code, as in AutoCAD MEP 2008 and 
earlier releases. This white paper explains the new panel 
schedules in more detail and provides an overview of how users 
can create their own custom panel schedules that match their 
company standard schedules. 

Understanding AutoCAD Tables and Field Codes 
The user should be familiar with how to create and edit AutoCAD tables. Tables are AutoCAD 
objects, unlike schedules, which are AutoCAD® Architecture software objects and AutoCAD 
MEP objects. While typical AutoCAD MEP schedules are maintained and edited in Style 
Manager, tables are maintained through AutoCAD software’s Table Style dialog box. You can 
find more information about tables and table styles in the help documentation (AutoCAD 
Help>User’s Guide>Annotate Drawings>Tables). 

Several different sample panel schedule table styles are included in AutoCAD MEP 2009. 
These table styles are located in the panel schedule table styles drawing found in the Styles 
folder (example for US Imperial is c:\Documents and Settings\All Users\Application 
Data\Autodesk\ACD-MEP 2009\enu\Styles\Imperial\Panel Schedule Table Styles (US 
Imperial).dwg for Microsoft Windows XP software). 

AutoCAD MEP 2009 electrical panel schedules also utilize AutoCAD field codes to populate 
the panel schedules with information from Circuit Manager. Please refer to the Help 
documentation (AutoCAD Help>Annotate Drawings>Notes and Labels>Use Fields in 
Text>Insert Fields) for more information about inserting fields into Tables. New special Field 
Codes (AEC Panel and AEC Circuit) have been created for use in panel schedules tables. 

 

New Circuit Manager Information 
New header and footer sections are in Circuit Manager for AutoCAD MEP 2009 to show more 
information about each panel. The header section contains information about the panel, such 
as voltage, rating, main size, enclosure type, and so forth. The footer section displays total 
panel load values as well as load breakdown by load category (with applicable demand 
factor), spare capacity, and phase balance. 

The middle section of Circuit Manager contains the circuit data for each panel. This section 
has been updated to show more relevant information (such as circuit total load, load on each 
phase) but is very similar to what appears in Circuit Manager in prior releases. 
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Figure 1: New Circuit Manager configuration for AutoCAD MEP 2009 

Panel and Circuit Field Codes 
As mentioned in the section above, the header and footer sections of Circuit Manager contain 
panel data while the center section contains circuit data. Every piece of data in Circuit 
Manager has a corresponding field code (either AEC Panel or AEC Circuit) that can be 
inserted into a panel schedule table style. When the panel schedule is inserted into a 
drawing, the field code displays the appropriate value. 
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Figure 2 : New AEC Panel field codes 
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Figure 3:  New AEC Circuit field codes 

Panel Schedule Table Styles 
Now that you have an understanding of AutoCAD tables, field codes, and the data available 
in Circuit Manager, we will review how these are used to create electrical panel schedules in 
AutoCAD MEP 2009. Open the panel schedule table style drawing (c:\Documents and 
Settings\All Users\Application Data\Autodesk\ACD-MEP 2009\enu\Styles\Imperial\Panel 
Schedule Table Styles (US Imperial).dwg) and look at some of the examples provided. For 
branch circuit panels, there are header and footer sections similar to what is shown in Circuit 
Manager. 

 
Figure 4: Sample layout of Three­Phase Branch Circuit Panel table style 

One important thing to note is that the circuit section of the panel schedule table only shows a 
few rows (three rows in this example). This is because panel schedules can vary in the 



CREATING CUSTOM PANEL SCHEDULES WITH AUTOCAD® MEP 2009 

 5 

number of circuits they contain. Instead of creating different schedules for every possible 
circuit configuration, only “unique” rows need to be created. 

In this example for a three-phase branch circuit panel, we want circuits 1 and 2 to display 
load values in Phase A, circuits 3 and 4 to display load values in Phase B, and circuits 5 and 
6 to display load values in Phase C.  We can stop at this point because circuits 7 and 8 need 
to display load values in Phase A again, similar to the first row, so this is no longer a unique 
row. The circuit section we have created will continue to repeat itself until all of the circuit 
data has been populated on the panel schedule that is inserted into a drawing. 

The circuit field codes are coded with special behavior that allows them to repeat until all of 
the circuits have been added. As such, only circuit field codes are allowed in a “circuit row” in 
the panel schedule tables. If any other type field code appears in a row with circuit field 
codes, the panel schedule is invalid and it cannot be inserted into a drawing.  

 
Figure 5: Circuit section of Three­Phase Branch Circuit Panel table style 

More information about how to create a panel schedule table follows in the next section. 

Creating a Panel Schedule Table 
The easiest way to create a panel schedule table is to start from an existing Microsoft Excel® 
software schedule and copy it in to AutoCAD MEP. 

Start a new drawing in AutoCAD MEP software, preferably using a “clean” AutoCAD template 
file such as acad.dwt. This will help keep the file size small and ensure that no Autodesk 
Architecture or AutoCAD MEP objects are present in the drawing. If you use the AutoCAD 
template you will need to edit the text style (Style command) to match your company 
standards and set it current before importing your table from Excel to minimize additional 
clean-up time. 

Open your existing Excel panel schedule, and save it as something else. This is important 
because you need to remove any unneeded circuit rows. Also, you should merge as many of 
the blank cells together as possible prior to bringing into AutoCAD MEP. This will make the 
table creation process much easier. 

The sample Excel file used as the basis for the three-phase panel schedule table in AutoCAD 
MEP 2009 is shown below. Notice that the circuit section only contains the three unique rows 
as previously mentioned. 
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Figure 6: Sample Microsoft Excel file used as starting point for table style 

After editing your Excel file, start a new drawing in AutoCAD MEP based on the acad.dwt 
template file. Be sure that the scale is set to 1:1 to allow the panel schedule to scale properly 
when it is inserted into a drawing. Select all of the cells in Excel, copy it, then select Paste 
Special as AutoCAD Entities into your drawing. Tip: Be sure to paste the file in the 
positive X,Y coordinate section and place it on Layer 0. 

 
Figure 7: Select AutoCAD Entities in the Paste Special dialog box 

The result should be a table that closely approximates the version you had in Excel. 
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Figure 8: New table created in AutoCAD MEP drawing 

This is probably a good time to mention that you should be saving often throughout this 
process! 

You will need to alter some of the cells widths to more closely match your desired final 
version, but this is a much easier process than trying to create a new schedule directly in 
AutoCAD MEP. The table may also have additional border lines that need to be deleted, such 
as the lines in the top row of Figure 8 above and in several rows in the footer section. 

It can very difficult to determine which cells have borders and which ones are just displaying 
the cell gridlines (similar to Excel). The easiest way to determine the difference is to do a plot 
preview. This will quickly show which items are borders (that will plot) and which one are just 
gridlines, which will not plot. If you receive an error message while trying to do a plot preview, 
be sure to set things up in the Page Setup Manager (File>Page Setup Manager…). 

While most of the borders from Excel will come across, the thickness (lineweight) may not be 
retained. You should format the border widths as desired in AutoCAD MEP to get the 
preferred look of the schedules. To edit borders, select a table cell (or multiple cells), right-
click, and select the Borders option. 
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Figure 9: Cell Border Properties dialog box 

You should also set the border color, border lineweight, and text color to be ByBlock and the 
linetype to ByLayer unless you want to force a specific value. The Row Style should always 
be set to Data (do not use Header or Title) and the Data Type should always be set to Text 
for all cells. All of these settings are found in the Properties Palette. 

 
Figure 10: Table properties in Property Palette 
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One additional thing to check is to make sure that Color of each Text entry is set to ByBlock. 
To do this you must manually edit each cell, but this is critical to ensure that all of the text is 
inserted properly. When the original file was copied from Excel, a lot of the text color was set 
to 0,0,0. Edit the text in each cell and set the color to ByBlock. Do this also for the cells in 
which you will be adding field codes. 

 
Figure 11 ­ Incorrect setting of 0,0,0 for text color in table 

Once you have modified the layout, borders, cell heights and widths, text styles, and so on, 
and input all of your “static” text, you should do a final plot preview to quickly verify things 
look as desired. 

 
Figure 12: Example of plot preview for table style 

Now, it is time to add your field codes to make sure your schedules use and display the 
correct data from Circuit Manager. 

Adding Field Codes 
The process of adding field codes for panel schedules is the same as inserting them into a 
regular table. Double-click in a text cell to be in edit mode, then right-click and select Insert 
Field…. Select the desired panel or circuit field code to display the desired information. The 
pictures below show how the AEC Panel and AEC Circuit field codes match up with the items 
in the header, footer, and circuit sections of Circuit Manager. 
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Figure 15: Circuit Manager footer section 

Here are some rules that must be followed when using the panel and circuit field codes in 
tables. 

1. Circuit field codes are unique because of their “repeating” behavior. As noted in an 
earlier section, you cannot have anything but circuit field codes in a row in your panel 
schedule table. If any other types of field codes are found in the same row as a circuit 
field code, the panel schedule will not be generated. 

2. It is not possible to use the circuit load field codes (Circuit Load Phase A, Phase B, 
Phase C) in the same table as the circuit total load field code. Refer to the existing 
styles as examples—the branch circuit panels utilize the circuit phase load fields 
while the switchboard and distribution boards use the circuit total load field. 

3. Panel load category field codes (Name, Connected Load, Demand Factor, Demand 
Load) also have a “repeating” behavior because the number of load categories on a 
panel will vary depending on the types of loads connected to it. If any other type of 
field code is in the same row as the panel load category fields, the row will not repeat. 
If only panel load category fields are in a row, the row will repeat until all of the load 
category rows have been populated. For a better understanding of this, refer to the 
load category section at the bottom of the distribution board schedule.  



CREATING CUSTOM PANEL SCHEDULES WITH AUTOCAD® MEP 2009 

 12 

 
Figure 16: Distribution Board Schedule table style 

The first three rows contain panel load category fields as well as other fields on the 
right (as marked above). These rows will not be repeated, but the fourth row only 
contains panel load category fields so it will repeat as many times as necessary to 
include all of the load categories on the panel. In the example below, there are eight 
load categories and the table automatically adjusts to include all of them. 

 
Figure 17: Example of a Distribution Board Schedule inserted into a drawing 

Creating the Table Style 
Once the formatting, text, and borders have been set up as desired and all of the field codes 
have been added, you are ready to create the table style to use for your panel schedules. Be 
sure to save your drawing then type Tablestyle at the command line and click the New… 
button. 
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Figure 18: Table Style dialog box 

Another dialog box appears asking for the new style name. Give your schedule a meaningful 
name such as 3-Phase Panel. The New Table Style dialog box appears and all of the settings 
should remain as-is, do not make any changes. The only thing to do is click on the button to 
select a starting table style to use. 

 
Figure 19: New Table Style dialog box 

After a table has been selected, the Preview window updates to show the new table. 
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Figure 20: New Table Style dialog box with updated preview image 

Click OK, then click Close on the Table Style dialog box and save your drawing. You now 
have a panel schedule table style that can be used for your electrical panel schedules. 
Repeat the process until you have created all of the desired panel schedule table styles that 
you need. You can create Tool Palette tools that point to this table style to facilitate the 
insertion of panel schedules.  

Modifying a Panel Schedule Table 
When modifying a panel schedule table style, you will need to reassign the style in the Table 
Style dialog after making your revisions to the table. 

To do this, make the necessary changes to the table style and save the drawing. Then type in 
Tablestyle to launch the dialog box shown previously. Select the name of the table to update 
then click the Modify… button. 
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Figure 21: Table Style dialog box 

In the next dialog box, click the button in the Starting Table section in the upper-left side of 
the dialog box. 

 
Figure 22: Modify Table Style dialog box 

Then click the Start From button and choose the updated table in the drawing. Click OK for 
this dialog then click Close on the Table Style dialog. Save the drawing and the updated table 
is now ready to be used. 

Using a Panel Schedule Table Style to Add Panel Schedules 
Once your table styles have been created, you are ready to use them in your construction 
documents. Your new panel schedule table style can be selected in the dialog box every time 
you run the PanelAdd command. Browse to find the file in the panel schedule style location 
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section then choose the desired panel schedule table style. In this example, we have created 
a new style called “MyCompanyPanel”: 

 
Figure 23: Panel Schedule Add dialog box 

A better way to use your new panel schedule table style is to create a tool on the Tool Palette 
with settings already predefined. Several panel schedule tools are currently available on the 
Tag & Schedule tab of the Electrical Tool Palette. 

 
Figure 24: Panel Schedule tools on Properties Palette 

To create a new tool, right-click on an existing tool, select Copy then right-click in an empty 
area of the Properties Palette and select Paste. The new tool will appear at which point you 
can right-click on it and select Properties. 
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